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MSWord 2003 –  
Finding the custom dictionary tools 
The instructions to follow are oriented to MSWord 2007.   

The instructions refer to finding the Custom Dictionaries menu through a 
pathway of button choices beginning with the “Office” icon, , which is 
featured on the extreme left of the upper menu bar. 

MSWord 2003 users can disregard the portion of the instructions referring to 
the pathway “Office icon/word preferences/Proofing”.   

 In MSWord 2003, the initial access to the custom dictionary is through the “Tools” 
menu.  
 The pathway is Tools/Options/Spelling and Grammar/Custom Dictionaries… 

 
 It is at that point, when you reach the  “Custom Dictionaries” button, 
that the instructions become the same for both MSWord 2003 and 
MSWord 2007. 

MSWord 2007 – Finding the tools 
The primary difference between Word 2003 and Word 2007 is the immediate 
“interface” of Word 2007.  

 It demands an immediate understanding of many icons and more levels of clicking 
to gain access to the tools menus familiar from Word 2003. However, there are 
improvements also.  Tools are in more logical groupings, such as “things that get 
inserted” are now all under the “Insert” menu, including tables. 
 MSWord also buries many highly desirable features that would greatly assist new 
users in a way only  accessible or noticeable to “advanced” [and very determined] 
users with time for exploration. This makes it very challenging to tame and control 
MSWord for your own purposes when under deadline pressure.  
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 This helpsheet offers a tested method by which the average user can take 
advantage of existing, but obscure, advanced MSWord capacity to create a 
custom dictionary efficiently and make it portable between computers.  
 Access the “Custom Dictionaries” menu through the “Office icon” button at the 
upper left corner. This opens a menu. Find the “Word Options” button at the 
bottom of the menu, then select “Proofing” from the list on the next 
menu to find the “Custom Dictionaries” button .   
 This gives access to the custom dictionaries tools menu. 
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Maximize your default custom dictionary 
 MSWord has a default Custom dictionary set up for you. All words you add to the 
dictionary automatically go into this file.   

 You can add words to it during a spell check or directly by accessing this 
dictionary through the Word/Word Options menu path. 
 First ensure correctness, and then add any words, surnames, special terms to 
your custom dictionary. 

 Regularly adding words, including names, unknown to the MSWord dictionary, 
reduces the amount of irritating underlining of words, and speeds the next spell 
check.   
 You can also delete incorrect words as needed through the “Edit Word List” menu, 
where you can highlight any word and use the “Delete” button. 
 If you never move your document from this computer, this may be sufficient. 

Why create a specialized custom dictionary? 
 One problem with these dictionaries is that they appear to have a maximum of 
about 250 words.  They can become too full.   
 It is therefore valuable to create additional dictionaries, particularly for different 
subjects, different languages, and specific projects, such as long-term research or 
a thesis, which need many surnames, specialized title words, and company names 
contained in bibliographies, added to the dictionary.  It is not efficient to add these 
words and names one at a time. 
 You can create a specialized dictionary at any time by going to the Custom 
Dictionary creating a new dictionary, give it a suitable name, activate it with a tick 

, and then add the desired words using this menu’s “Edit Word List” button, or 
during a spell check. 
 However, if you already have a long list of words you wish to add, it can be a slow, 
irritating nuisance to add them one by one. 

Create a custom dictionary from a list 

 The most common existing list containing 
words that are unknown to the MSWord 
dictionary, is a bibliography (reference list).  
 The names and specialized words will be 
underlined in red because they are unknown to 
the MSWord dictionaries.  
 If you do not add all the underlined words, 
(including surnames you know are correct) to 
your custom dictionary during a first spell 
check, the next spell checks will repeatedly 
stop at these words. 
 You can create a dictionary of surnames, 
specialty words and abbreviations from any 
existing bibliography(ies). This allows you to 
bypass the bibliography in subsequent spell 
checks or requires adding only new words from 
later additions to the bibliography. 
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Step-by-step instructions 

 Please follow the steps carefully, as MSWord does not make this easy to do. The 
dictionaries are hidden from all but the most advanced users, yet it is less 
experienced users who need this feature the most. This is how to get around the 
gatekeeping. 

Create a plain text document from your bibliography 

 First turn an existing bibliography into a 
plain text list of words in a “txt” document. 
Copy/paste the bibliography into a new 
document and save to your desktop.  

 On the Home menu, find “Select” and 
then “Select all”  to highlight the entire 
text. Then, strip all styling from fonts, 
words and paragraphs. How? Find the 

tiny Styles “down arrow”  button, 
open the styles menu, then find and click 
the “Clear All” feature.  
 Save this as a plain text document on 
your desktop with the name of your choice 
(*.txt). A new “File conversion” menu will 
appear. Select “Other encoding” and then 
“Unicode” on the list to the right. Okay. 
Save. Close. 
 When you re-open this document, you will 
see that hyperlinks have also been 
stripped out by this “Save”. 

Turn the bibliography into a clean list 

 The next steps are illustrated below. 
 First, reduce the entire list to single word paragraphs. How? On the “Home” menu, 
Use the “Replace” features (far right of Home menu).  

 In the “Find what” slot, hit the space bar once to insert a space.  “Replace with”: 
Use the “more” button to find the “special” button. Select “paragraph mark”. Hit 
“replace all.” Exit the menu.  
 You will now be able to see the text as one-word paragraphs.  

 On the Home menu, find the Sort button. sort alphabetically by paragraph 
 Clean out all “junk”, paragraph marks, duplicates and any other words you don’t 
want. Also clean out all punctuation. You can use the Replace function  to find 
each item, such as a comma, and replace with nothing (clear all content from 
the replace slot to ensure there is nothing), then hit “Replace all”. Finally, check 
the very end of the document, after the last “Z” word, for remaining junk. Delete.  
 See illustration on next page  

 Then cut out all words (highlight and delete) that are not underlined by the spell 
check. You may wish to keep some surnames and specialty words that are not 
underlined, as a precaution.  
 Save this clean list. Ensure it remains a “txt” document. Keep it open. 
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Add the list to a custom dictionary 

 Follow the following steps carefully in order. 
Create a new custom dictionary 

 First, go to the custom 
dictionaries menu (as shown in 
the “Default custom dictionary” 
section: Create a new custom 
dictionary, giving it a clear name 
(i.e. ““thesis”; “Physics”; 
“Geography”; or “bibdictionary”).  
Ensure it is activated with a tick 

. Okay. 
 Don’t forget the name. The 
next task is to search for it. 
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Search for it in MSOffice 

 Using the 
Microsoft 
search 
available from 
the “Start” 
button  
on the lower left 
of your screen, 
use the search 
with advanced 
options.   
 Enter the name 
of your new 
dictionary file in 
the “All or part 
of the file name” 
box. 
 (C) drive is 
correct to 
search in the 
MS Office 
folders.  
 You need to 
search in 
system folders, 
hidden files and 
folders and 
subfolders. Tick these boxes  
 Then search. When your dictionary appears, click on the file name to open it.  It 
will open in “Notepad”. 

Move the list into the dictionary 

 Go to the list document you 
previously created. Select all to 
highlight the entire list. Copy.  
 Go back to the dictionary file you 
just opened. Paste in the list. Save.  

Check that the steps all worked 

 Now check the dictionary from 
within MSWord.  Open a new blank 
document. Go to the Custom 
dictionary menu, where this 
dictionary should be ticked. Click 
the “Edit word list” button to check 
that the word list is in it.  
 You now have a custom dictionary 
that will work on this computer. 
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Problem: Moving your document to a different 
computer leaves the dictionary behind 

 The main problem arising for students is that the custom dictionary is stored deep 
in hidden folders inside MSOffice, and remains on one computer.  

 If you use only one laptop, and never change computers, then you will not have 
any problems.  

 However, if you use a USB key, and change computers, you can lose contact with 
your custom dictionary, and all the work you did to add words.  

 Many words you previously checked and entered into the custom dictionary will 
re-appear with red underlining as though they have never been spell-checked.  It 
is both irritating and time consuming to do the check again.   

 It is therefore valuable to create a portable custom dictionary which you can keep 
with your document and template in a portable folder kept on a USB key for 
transfer between computers.  When you document is attached to this dictionary 
within that portable folder, the words previously checked remain checked, and you 
can continue to add new words no matter where you are working. 
 You first need to create a specialized custom dictionary, then move it to your 
portable folder. 

Moving a dictionary to a portable folder 

You can copy any custom 
dictionary to your portable folder.  

 As before, search for the 
dictionary. If you wish to copy 
more than one to your portable 
folder, search for “*.dic”  
 Click on the dictionary name. 
Copy it, open your portable 
folder and paste it there.  

Attaching the dictionary to a 
document in the portable 
folder 

 In the portable folder, open the document you wish to use.  
 Then go to the Custom dictionaries menu (as shown in the “Default custom 
dictionary” section: Pathway: Office/Word Preferences/Proofing/ or 
Tools/Options/Spelling & Grammar/ to find the button and menu for Custom 
dictionaries).  
 Click the “Add” button. Browse to find and open your Portable Folder. You should 
be able to see the “.dic” file you just pasted into the folder. 
 Open this file and save it under a new, 
unique name.  Delete the old version. 
 Click on this newly named dictionary to 
highlight the file. Then click the “Open” 
button. The name should appear in the 
dictionary list with the tickbox  already 
ticked. This means the dictionary is activated. 
You can verify this by checking the filepath. 
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 Finally, untick the dictionary named “CUSTOM.DIC”. Hit Okay. This ensures that 
the document is attached ONLY to dictionaries in the portable folder. 
 You can attach more than one dictionary in the portable folder to this document. 
Just be sure that each has a unique name, so it cannot be confused with those in 
the MSWord UProof (or Proof) folder on this computer. 

Using the dictionary 
 As long as you move the portable folder, keeping the dictionary and document 
hyperlinked together within it, your spellcheck will utilize this dictionary. 
 Now that you have this dictionary attached (hyperlinked) to your document, you 
can use the spell check’s “add to dictionary” button, or the Custom Dictionary 
menu’s “Edit Word List” button, to add individual, new words to the dictionary. 

 You can verify this by adding a new word to your document.  Highlight it, 
spellcheck it, add it to the dictionary, then go to the Custom Dictionary menu’s 
“Edit Word List” button to open the dictionary, scroll down and find the word.  

 You can add lists of words to the dictionary at any time. 
 Create a new word list “.txt” document, open this dictionary file, and copy/paste 
the list in. 
 Also consider searching for and opening the old CUSTOM.DIC, copying those 
previously entered words, and pasting them into your portable dictionary. 
 It does not seem to matter that you do not alphabetize the words when you 
paste them into the open text document.  Viewed from within the custom 
dictionary “Edit word list” feature, they appear in alphabetical order. 
 


